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Abstract. Anti-patterns and code-smells are signs in the source code 

which are not defects (does not prevent the program from functioning 

and does not cause compile errors) and are rather indicators of deeper 

and bigger problems. Exception handling is a programming construct de- 

signed to handle the occurrence of anomalous or exceptional conditions 

(that changes the normal flow of program execution). In this paper, we 

present an Eclipse plug-in (called as Parichayana) for detecting exception 

handling anti-patterns and code smells in Java programs. Parichayana 

is capable of automatically detecting several commonly occurring excep- 

tion handling programming mistakes. We extend the Eclipse IDE and 

create new menu entries and associated action via the Parichayana plug- 

in (free and open-source hosted on GitHub). We compare and contrast 

Parichayana with several code smell detection tools and demonstrate 

that our tool provides unique capabilities in context to existing tools. 

We have created an update site and developers can use the Eclipse up- 

date manager to install Parichayana from our site. We used Parichyana 

on several large open-source Java based projects and detected presence 

of exception handling anti-patterns. 
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1  Features, Hosting, Novelty & Experimental Results 

Figure 1 shows a snapshot of Parichayana. The Eclipse plug-in can be used to 

browse all detected code smells and immediately go to the location of the indi- 

vidual code smells in the Java source code (which is colored) to start refactoring 

in the Eclipse Java code editor. Markers are the Eclipse mechanism for resource 

annotations. We use markers to show the user what code smells were detected by 

the plug-in and where in the source code they can be found. We briefly describe 

the framework and libraries we use to create and deploy Parichayana. We use 

Eclipse Luna which includes full support for Java 8 in Java development tools 

and plug-in development tools. We use the Eclipse Plug-in Development Envi- 

ronment (PDE) which consists of PDE UI (editors, wizards and launchers), API 



 

 
 

Table 1. List of 14 Anti-Patterns and Code-Smells Detected by Parichayana 

 

 CODE  

 

DESCRIPTION 

1 PSTE Printing stack-trace and throwing Exception, choose one otherwise it results in multiple 

log messages (multiple-entries, duplication) 

2 LGTE Logging and throwing Exception, choose one otherwise it results in multiple log messages 

(multiple-entries, duplication) 

3 WEPG Wrapping  the  exception  and  passing  getMessage()  destroys  the  stack  trace  of  original 

exception 

4 RRGC Relying on  the  result  of getCause  makes  the  code fragile,  use 

org.apache.commons.lang.exception.ExceptionUtils.getRootCause(Throwable throw- 

able) 

5 RNHR Just returns null instead of handling or re-throwing the exception, swallows the exception, 

losing the information forever 

6 MLLM Using multi-line log messages causes problems when multiple threads are running in par- 

allel, two log messages may end up spaced-out multiple lines apart in the log file, group 

together all log messages, regardless of the level 

7 CTGE Catching generic Exception, catch the specific exception that can be thrown. If swallowing 

it then a problem but if re-throw then it is OK 

8 LGRN Log and return null is wrong, instead of returning null, throw the exception, and let the 

caller deal with it 

9 PSRN Print stack-trace and return null is wrong, instead of returning null, throw the exception, 

and let the caller deal with it 

10 THGE Throws generic Exception, defeats the purpose of using a checked exception, declare the 

specific checked exceptions that your method can throw 

11 INEE Ignoring or suppressing InterruptedException with an empty catch-clause is an anti- 

pattern, empty catch block prevents in determining that an interrupted exception occurred 

or knowing that the thread was interrupted 

12 LGFT If this is really a fatal condition then the method should abort and notify the caller of the 

fatal condition with an appropriate exception rather than only using log.fatal in the catch 

block 

13 CNPE NullPointerException is a logical or programming error in the code (result of a bug) and 

should be eliminated rather than catching. If you anticipate that a null will be returned 

then explicitly test for it 

14 TNPE NullPointerException should not be thrown by the program as it is expected that it is 

thrown by the virtual machine 

 

 

tools and build facilities. We use the Eclipse JDT (Java Development Tools) and 

the Eclipse AST (Abstract Syntax Tree) libraries to access and read the elements 

of a Java program. The AST is a detailed tree representation of the Java source 

code (comparable to the DOM tree model of an XML file). We use the classes 

in org.eclipse.jdt.core.dom package such as CatchClause for extracting the body 

of a catch clause. 

Parichayana is a proof-of-concept hosted on GitGub3 which is a popular web- 

based hosting service for software development projects. We provide installation 

instructions and a facility for users to download the software as a single zip-file. 

Another reason of hosting on GitHub is due to an integrated issue-tracker which 

makes reporting issues easier by our users (and also GitHub facilitates easier 

collaboration and extension through pull-requests and forking). Parichayana is 
 

 

3     https://github.com/ashishsureka/parichayana 



 

 

 

Table 2. Exception Handling Anti-Pattern Detected by CHECKSTYLE, FINDBUGS, 

JEXCRULE, PMD and PARICHAYANA 

 

  CHECKSTYLE FINDBUGS JEXCRULE PMD PARICHAYANA 

1 PSTE - - - - • 

2 LGTE - - - - • 

3 WEPG - - • • • 

4 RRGC - - - - • 

5 RNHR - • - - • 

6 MLLM - - - - • 

7 CTGE • • - • • 

8 LGRN - - - - • 

9 PSRN - - - - • 

10 THGE • • - • • 

11 INEE - - - - • 

12 LGFT - - - - • 

13 CNPE - - - • • 

14 TNPE - - • • • 

 

 

easy to install and use through a zip file4 or update site5. We created a Teaser 

Video6 and a Screencast7 for Parichayana. 

Listing 1.1. Utils.java, (JOOQ - LGRN ) 
 

 
 

Listing 1.2. RemoteJMeterEngineImpl.java, (JMETER - LGTE ) 
 

 
 

Listing 1.3. HttpSSLProtocolSocketFactory.java, (JMETER - MLLM ) 
 

 
 

Listing 1.4. ContentCryptoMaterial.java, (AWS - WEPG) 
 

 
 

 

4   https://dl.dropboxusercontent.com/u/48972351/PARICHAYANA.zip 
5    http://www.snpe.rs/in.software.analytics.parichayana.updatesite 
6   https://www.youtube.com/watch?v=MJ  omsGmgvU 
7    http://www.youtube.com/watch?v=QwccDyaxppw 

catch  ( Exception  f a t a l )  { 
l o g . e r r o r (” Cannot  p a r s e  P o s t g r e s  a r r a y :  ” +  r s . g e t S t r i n g ( index ) ) ; 

l o g . e r r o r ( f a t a l ) ; 

return   null ; 

} 

catch ( Exception ex ) { 
l o g . e r r o r (” r m i r e g i s t r y  needs  to  be  running  to  s t a r t  JMeter  i n  s e r v e r  ” 

c→   + ”mode\n\ t ” +  ex . t o S t r i n g ( ) ) ; 
throw  new  Remote Exception (” Cannot   s t a r t .   See   s e r v e r   l o g   f i l e . ” , ex ) ; 

} 

catch  ( I l l e g a l A r g u m e n t E x c e p t i o n  e )  { 
l o g . warn (” Could  not  s e t   p r o t o c o l   l i s t :  ” +  p r o t o c o l L i s t  +  ” . ” ) ; 

l o g . warn (” Valid  p r o t o c o l s  a r e :  ” +  j o i n ( sock . g e t S u p p o r t e d P r o t o c o l s ( ) ) ) 

c→  ; 

} 

 

http://www.snpe.rs/in.software.analytics.parichayana.updatesite
http://www.youtube.com/watch?v=MJ
http://www.youtube.com/watch?v=MJ
http://www.youtube.com/watch?v=QwccDyaxppw


 

 

 
 

 
 

Fig. 1. A Screenshot of Parichayana Eclipse Plugin showing the Problems View, List 

of Anti-Patterns Discovered (Categorized into Errors and Warnings) and the Editor 

Window showing Problematic Code highlighted and Underlined 

 

 

 
 

Listing 1.5. Neo4jExceptionTranslator.java, (NEO4J - RRGC ) 
 

 

Table 1 displays the list of 14 anti-patterns8 and code-smells detected by 

Parichayana (these are well known gpatterns and not proposed by us – our 

goal is to build a tool implementing the known ant-patterns). Table 2 shows a 

feature comparison (on exception-handling anti- patterns) of Parichayana 

with several widely used and popular code-smell de- tection tool. Table 2 

reveals that Parichayana features are novel and unique in context to existing 

tools. We conduct a series of experiments on several open- source projects 

(such as Apache JMeter, Apache Tomcat, JFreeChart, Junit, Neo4J and 

JOOQ) consisting of millions of lines of code and thousands of Java classes. 

Experimental results demonstrate presence of various exception han- dling 

anti-patterns and throw light on their intensity. Listings 1.1 − 1.5 shows five 

different exception handling anti-patterns detected by Parichayana. Listings 

1.1 − 1.5 displays the Java class file, name of the open-source project and the 

anti-pattern detected. 
 

 

8        https://today.java.net/article/2006/04/04/exception-handling-antipatterns 

 

 

 

catch  ( I l l e g a l A r g u m e n t E x c e p t i o n  i a e )  { 
i f   ( i a e . get Cause ( )  !=  null  &&  i a e . get Cause ( )   instanceof  

c→  I n v a l i d E n t i t y T y p e E x c e p t i o n )  { 
throw  ( I n v a l i d E n t i t y T y p e E x c e p t i o n ) i a e . ge t Cause ( ) ; 

} 
throw  new  Invalid Data Access  Api Usage Exception ( i a e . get Message ( ) , i a e ) ; 

} 



 

 

 

 
 

 

1 Parichayana Installation 

Parichayana plug-in can be seamlessly integrated with Eclipse. Parichayana is 

easy to install and use. Parichayana can be installed similar to other popular 

third party plugin-ins available for Eclipse (via the Update Manager). The in- 

stallation processing consisting of Selecting the Install New Software menu item 

from the Help Menu. Then in the Available Software dialog enter the update 

site3 into the work with field. A restart will be required after confirming the 

unsigned software. Parichayana is easy to install and use through a zip file4 also. 

Figure 1 is a snapshot of the Parichayana copyright, version, plug-in details and 

icon (the command link Help > About Eclipse dialog summarizes information 

about the installation). We select GPL license so that our code can never be 

closed-sourced. 

 
2 Problems View 

Figure 2 shows the snapshot of the Problems View showing problems, errors and 

warnings logged by Parichayana. Through the Problems View, a user can browse 

all detected code smells and immediately go to the location of the individual 

code smells in the Java source code (which is colored) to start refactoring in the 

Eclipse Java code editor. Double-clicking the icon for a problem, error or warning 

will automatically open the relevant line of code in the editor for the associated 

resource. As shown in Figure 2, the problems in the problem view are grouped 

based on severity. For example, all errors are grouped together. The Problems 

View shows the name of the exception-handling anti-pattern and its description. 

Also, multiple filters can be added to the Problems View for enabling or disabling 

certain problem types. 
 

 

3   http://www.snpe.rs/in.software.analytics.parichayana.updatesite 
4   https://dl.dropboxusercontent.com/u/48972351/PARICHAYANA.zip 

 

http://www.snpe.rs/in.software.analytics.parichayana.updatesite


 

 

 
 

 
 

Fig. 1. A Snapshot of the Parichayana Copyright, Version, Plug-In Details and Icon 

 
 

3 Editor with Problematic Code 

Markers are the Eclipse mechanism for resource annotations. We use markers 

to show the user what code smells were detected by the Parichayana plug-in 

and where in the source code they can be found. Problems view shows a list 

of all errors and warnings (tabular representation: name of the anti-pattern, 

location, and description) and double-clicking the problem, focuses the Eclipse 

editor on the marked item. As shown in Figure 3, the marked item in the editor 

(problematic code) is underlined in either red or yellow color. Errors are shown 

in red color and warnings are shown in yellow color. Similarly, different icons 

are displayed for error and warnings. As shown in Figure 3, a tooltip shows-up 

when the user points the mouse on the marked item or the problematic code. 

 
4 Ouptut Report 

Snapshot (A) in Figure 4 shows the Parichayana output report. Parichayana 

output report consists of the problematic code and the anti-pattern name and 

description. The output report consists of only those anti-patterns which are 

enabled in the preference page. In order to generate the output report, a user 

needs to right-click on the project and select Open Parichayana Output File 

(refer to Snapshot (B) in Figure 4). The output report is also generated by 

selecting Project and then Clean (refer to Snapshot (C) in Figure 4). 

 
5 Preference Page 

The Parichayana plug-in user is able to make a selection from the set of avail- 

able code smells, either by making a selection prior to the start of the smell 



 

 

 

 
 

Fig. 2. A Snapshot of the Problems View showing Problems, Errors and Warnings 

logged by Parichayana 

 

 

detection process, or by filtering the plug-in results after the detection has taken 

place. Eclipse’s preferences dialog, available from the Window menu, contains 

a hierarchical list of user preferences. These preference pages are to be used to 

set preferences for the plug-in, like enabling or disabling detection of a certain 

type of code smells. Figure 5 shows a snapshot of Parichayana preference page 

displaying 14 exception handling anti-patterns and a drop-down box from which 

one can make one of the three selections: Error, Warning and Ignore. A user can 

search a smaller set of preference titles by using the filter field at the top of the 

left pane. Preferences in Eclipse are stored as key and value pairs. The key for 

the preference is an arbitrary String. The value can be a boolean, String, int or 

another primitive type. The preference support in Eclipse is based on the Pref- 

erences class from the org.osgi.service.prefs package. Parichayana also contains 

a progress monitor to give user the feedback that something is running. 

 

6 Preference Setting using Regular Expressions 
 

Parichayana provides a per-project basis preference setting. A user can set plug- 

in preferences on a per-project basis, as opposed to a situation in which settings 

are made system-wide. Using regular expressions, one can set class and package- 

level code smell detection. The plug-in presents the user with a user interface as 

shown in Figure 6, allowing the detection of code smells in selected packages and 

classes. For example, a caret symbol followed by in\\ will exclude all packages 

starting with in. The regular expression syntax accepted by Parichayana is the 

same as used by the java.util.regex API for pattern matching (similar to the Perl 

programming language). A regular expression can specify complex patterns of 

character sequences and enables the user to search for patterns in string data by 



 

 

 

 
 

Fig. 3. A Snapshot of Eclipse Editor displaying Marked Items (Problematic Code) 

which are Errors and Warnings. Errors are shown in Red Color and Warnings are 

shown in Yellow Color 

 

 

using standardized syntax conventions. Filtering using regular expressions is very 

useful as one can easily include and exclude files which needs to be processed. 

We created a Teaser Video5 and a Screencast6 for Parichayana. 

We believe and encourage academic code or software sharing in the interest of 

improving openness and research reproducibility. We release our exception 

handling anti-patterns detection tool Parichayana in public domain so that other 

researchers can validate our scientific claims and use our tool for comparison 

or benchmarking purposes. We believe our tool has utility and value in the 

software industry as it helps practitioners in improving code quality and in the 

spirit of scientific advancement, select GPL license (restrictive license) so that 

our tool can never be closed-sourced. Some of the close related work are: 

[1][2][3][4] 
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Fig. 4. (A) Snapshot of Parichayana Output Report (B) Snapshot of a Contextual Men 

Item showing how to generate Parichayana Output Report (C) Snapshot of a Menu 

Item demonstrating how to Execute Parichayana 
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Fig. 5. A Snapshot of Parichayana Preference Page displaying 14 Exception Handling 

Anti-Patterns and a Drop-Down Box from which One can make One of the Three 

Selections: Error, Warning and Ignore. 

 

 

 

 

 
 

Fig. 6. A Snapshot of Parichayana Interface for Filtering Classes and Packages using 

Regular Expressions 


